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Installing UMB-Config-Tool

Start ‘Setup_UMB_Config_xxxxxxx.EXE’ and follow the instructions of the installation
programme.

The software is installed under ‘C:\Programme\Luff\UMB-Config’ as standard.
Start the application with ‘Start’ > ‘Programme’ = ‘Lufft UMB Config’ - ‘Config Tool'.

Installation paths:

Path Content
...\Programme\Lufft\UMB-Config\ Application and INI files
...\Programme\Lufft\UMB-Config\Firmware Device firmware (mot files)
...\Programme\Lufft\UMB-Config\Hexload Bootloader programme
...\Programme\Lufft\UMB-Config\Konfig Stored device configurations

Copy the current device firmware into the firmware directory prior to installing updates.

The UMB-Config software can be uninstalled with ‘...\Programme\Lufft\UMB-
Config\UNWISE.EXE’.

System requirements
Windows 2000 / XP

5 MB free hard disk capacity
a free serial interface (COM)
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Creating a sensor list

Menu: Edit > Sensors:

=10l
Sensor Selection
Tupe of Sengzar In]
[vvs20ume =
SavedExit |
Tha ] Delete | Madify Corfigure | Cancel/Exit |
Update Channellizt | Firmwareupdate Sensor |

Selected Sensors

D IT_l,lpe Adress IChanneIs IActive Channels I
1 W5 20-LMBE 12289 33 a
Click Sensor to edit/remove Sensor Double Click Senzor to edit active channels
Autozcan | Werify | Save to Disk | Load from Disk |

Status 23.02.2007 Version 1.2

Choose ,Type of Sensor’; enter an ID and add it with ,Add’ to the list. With ,Delete’ sensors
can be deleted, with ,Modify’ a sensor in the list can be modified. The sensor shown in

,Sensor Selection’ will be deleted or modified.

,Configure’ starts the configuration of the sensors in the list. ,Firmwareupdate Sensor’ starts
the module for updating the firmware of the selected sensor. ,Update Channelliste’ reads the
channel list from the connected UMB-module / sensor and inserts new channels into the

existing channel list for this device.

Running ,Autoscan’ queries the network for existing UMB devices. ,Verify’ checks, if the

devices in the list are responding to communication from the master.

With ,Save to Disk’ the sensor list (including selected channels) can be stored for later reuse

(,Load to Disk’).

Lufft
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Configuring sensors

Select a sensor from the list by clicking it, then click ,Configure’. You will get the following
dialogue:

ol

Select zenzor to configure

|12289 'l

Load profile from sensor |

Load profile from disk. |

Stare profile on sensor |

Store profile on disk |

Load ad) data fram disk |

Cloze |

Load the configuration of the sensor with ,Load profile from sensor’. Adjust the values in the
mask to suit your needs.

=i

I ait I Info

General properties Communication properties

Id [ = Linespeed [15200 -]
Drescription Ivisibilit}l-sensor W5 20-UMB Pratakall Ibinal}' "l
Timeout protocol change 10 -

Output properties Measzzurement Setup

Output mode

Failure current [rd.)

Scaling

|4..20mA 'l
|2 Ev
ID.. 2000 m 'l

Ayerage for wisibility [min]
Qffzet far vizibility

Border contrast

Awerage for temperauture [min] |5 vi
IU 3‘-

Qffget for Temperature

Calibration values

DAC offset

DAL gain

E7.30975 Calibration walue
162.22827 Calibration offset

7932.44336

0.00076

Calibration status

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany
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After the values have been set, store them on the device with ,Store profile from sensor’.

T=

Select zenzor to configure

Load profile from sensor | I‘I 2289 - l

Load profile from dizk |

Store profile on sengzor |

Store profile on disk |

Load adj, data fram disk |

Cloze |

With ,Store profile on disk’ a sensor configuration might be stored on a hard drive. Stored
configurations of sensors might be loaded with ,Load profile from disk’.
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Assigning Device ID’s
Each device in a UMB network requires a unique address.

Addressing takes place via a 16 bit address. This is divided into a sensor class ID and a
device ID.

To avoid address duplication, the device ID’s are assigned in ascending order per sensor
class (i.e. sensor type):

=loix]
Sensor Selection

Tupe of Sengzar In]
| ANACON-UME N

Save/Exit |

Add i Delete | b audify Configure | Cancel/Exit |
Update Channellizt | Firmwareupdate Sensor |

Selected Sensors

D IT_l,lpe Adress IChanneIs IActive Channels I

1 IRSZ1COMN-UME 4097 26 a

2 IRSZ1COM-UE 4098 28 a

3 IRSZ1CON-UME 4099 26 a

1 R25-IkB 2153 ] a

2 R25-UrE 2194 9 a

1 WE20-LIMB 12289 33 a

2 WS 20-LME 12290 33 a

1 AMACOM-UME 24577 137 a

2 AMACOM-UME 24578 137 a

3 AMACOM-UME 24579 137 a

4 AMACOM-UME 24580 137 a

Click Sensor to edit/remove Sensor Double Click Senzor to edit active channels
Autozcan | Werify | Save to Disk | Load from Disk |

ATTENTION: When configuring new equipment please note that new devices always have
the ID 1! If there are several sensors of the same type in a network it makes sense to
configure the sensors individually with their corresponding ID’s before commissioning the
network.

Lufft
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Configuring ANACON-UMB

As the ANACON-UMB is a universal measurement transmitter which can be operated with
various analogue sensors, this module must always be configured to the connected sensor
before commissioning.

To do this, connect the module to the power supply (with no additional participants on the
bus) and connect to the PC via an RS232 cable (1:1). Load the current configuration via
‘Load profile from Sensor’ as in the section ‘Configure Sensor’:

Select the connected sensor type in ‘Measurement Setup’ under ‘Channel 1° and ‘Channel 2’

Sensorl:onfig =lEx]
Main | Irfo Anacon-LUMB I
General properties Communication properties
Id | Linespeed RS232 |
Description IW Pratokoll I binary jv
Timeout protocol change 10 =

Meazsurement Setup

Gereral Parameters  Channel 1 | Channel 2|

Sensortype Meassurement category Lnit
ﬂ Itemperature I“E
= M aw-value Offset it Unit from Channel
j700 {0.000 | =l
combi wind [3368.01) Overrange [%] Sengor powerup time [ms]
combi wind 4. 20mé extern m m
c:_ombi wind 4. 20mé, intern sl x
air pressure (8355 03 Mumber of samples for average
|5 j |1 2 j Awverage aver B0 &

Channel description
Ichannel 1

If necessary, set the ID, measurement interval and number of measurements for the min-,
max- and average values:

Meazzurement intervall [z] Murmnber of zamples for average

| |1 2 3| Aversge over B0 s

Then save the amended configuration in the module with ‘Store profile on sensor’ under
‘Main’.

ATTENTION! In the case of the temperature/humidity sensor (TFF 8160.TFF), the
values for C12 and C76, which are marked on the sensor head, must be recorded
under ‘General Parameters’!!!

General Parameters | Channel 1 | Chanrel 2|

Altitude f250 =

TFF C12

TFF C76 1560 3l

Lufft
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Query measurement values

The channel list of a sensor is opened by double clicking a sensor in the sensor list.

Select active Channels =10 x|
Chir. |Measurement |Unit |F|ange |f-‘«ctive ' 21 Click an Channel ta toggle active
100 Act. temperature T -200.00 .. 450,00 s
120 Min. temperature “C -200.00 .. 450,00 inactive
140 Max. temperature T -200.00 .. 450,00 inactive
160 Awa, temperature “C -200.00 .. 450,00 inactive
105 Act. temperature F -328.00 . 842100 -

125 Min. temperature F -328.00 ., 842,00 inactive
145 tax. temperature F -328.00 .. 84200 inactive
165 Ayg. temperature F -328.00 ., 842,00 inactive
110 Act. deswpaint C -200.00 .. 450,00 inactive
130 in. dewpoint T -200.00 ., 450,00 inactive
150 Maw. dewpoint ‘C 20000 . 45000 |inactive OK |
170 Avg. dewpaint T -200.00 .. 450,00 inactive LI

Here you are able to select the channels for query.
The measurement is started in menu ,File’ > ,Start measurement’.

[E] config-Software-UMB - COM3 - 19200 =10l

File Edit Calbration Help

AMACOM-UME ID1 temperature [*C] Act |AMACOM-UME 101 temperature [*F] Act  |AMACOM-URB 107 relative humidity [%]  [ANACOM-UME |01 abzalut humidity

Act [g#ni] At
25.38 7768 3333 782
283 77.ER 3376 792
25.38 77ES 3384 7.94
25.38 7768 3384 7.94
25.38 7TES 3384 7.94
25,38 77ER 3276 792
25.38 7768 3376 792
25.38 7TES 3376 792
25,38 77ER 3276 792

To change the sampling rate of the software click ,Edit’ a ,Sampling Rate’.

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 9
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Firmware Update

Before implementing any update, please check with Lufft concerning the current firmware
status of the UMB products.

Check current firmware status
The current status of the firmware should be checked before updating the firmware. To do

so, read the configuration under ‘SensorConfig’. The current version of the software is shown
under ‘Rev. software’ on the ‘Info’ page.

sensorConfig I ] 4
Main {Infs | R25-UMe |

Humber |‘I

Tested 708
Froject number |?

Fiew. azzembly |S

Rev. schematic |3

R, hardware |8

@ zoftware |43\)

Rev. product |U

Clags-id |2

Mame [R25-UME

43 corresponds to Version V4.3

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 10
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Programme Sensor Update

Before the update, save the current device firmware (mot file) in the installation directory
under ‘Firmware’ (e.g. C:\Programme\Luff\UMB-Config\Firmware).

ATTENTION: When updating ANACON-UMB or IRS21CON-UMB, the RS232 connection
must be plugged directly into the module to be updated.

Open the sensor list under ‘Edit’ > ‘Sensors’; if necessary, regenerate the list with ‘Autoscan’
or load a stored list with ‘Load from Disk’. With ‘Verify’, check whether the sensors available
in the sensor list are also reachable on the network.

[Ero15ensorpefinition [ m] |
Sensor Selection
Type of Sensor [n]
fvs20UmB =N
Save/Exit |
Add | Delete | I odify Configure | Cancel/E =it |
Update Channellizt | Firmnwareupdate Sensor |
Selected Sensors
D IT_l,lpe Adress Chatinelz Active Channels
L VS20UMB 12283 3 o
1 IRSZ1COM-UME 4097 26 a
1 AMACOM-UME 24577 137 a
2 AMACOM-UME 24578 137 a
1 R25-IkB 2153 ] a
Click Senzor to edit/remave Senzar Dauble Click Senzor to edit active channels
Autoscan | Werify | Save to Dizk | Load from Disk |

Select the appropriate sensor from the sensor list; the selected sensor is displayed in the
‘Selected Sensors’ section (VS20-UMB in the example).

The update process is started with ‘Firmwareupdate Sensor’. The following window opens
when this function of the Config-Tool is used for the first time:

%4

o Uﬂt m m

b dy . Lu €ss- un egetec ni , Felibach, Germany
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Select path to Hexload-Program 2lx
Suchen ir I (25 UMEB-Config j = 5 ER-
L) Hexload
|- Konfig
Dateinarne: I j {ffnen I
D ateityp: IHe:-:Ioad progran j Ahbbrechen |
FA

Under ‘Hexload’, select the ‘HexLoad.exe’ file.

After this (and on all future updates) a window opens in which you select the relevant mot file
for the update:

Firmware to update current active sensor ﬂil
Suchen in: IE} Firrware j 4= |‘=_°F v

2“’ 0007_RRS_Release_W42.mot
;P“’ anacon_release_W11.mot
;?"' isncon_release_Y12.mok

: i) |

[ateiname: Ivs2D_reIease_V'| E.mot j Qffnen I
j Abbrechen |
A

[ ateityp: I Firrnware file

Uﬂt G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 12
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The device is then programmed:

Status 23.02.2007 Version 1.2

=10/
File Edit Wiew Target Options Window Help
.ﬂ Project ;Iglﬁl E—: Target ;lglil
Hexfile: V520_RELEASE_V16.MOT Range: EB00D - FDFEF
COM Port: COM1 CRC: —
Baudrate: 19200 Application: BTL_¥S20_¥3 Jun 6 2006 16:04:
CPU: M16C{28 64pin
BTL Yersion BTL V3.00

HE.! Current data - [D:"PROGRAMME' LUFFT, UMB-CONFIG FIRMYWARE" ¥S20_RELEA

Address: [0xEB000 [ 2|

=10l x|

Clear target started
Clear target succeed
Frogramming target ztarted

K3

fiddress [ B |1 ]2 [3 [4][5]6 789 [A[B][C[D]|E]F][ASCII li’

E8PAA |FC EF 70 95 18 B5 68 FO BB 96 C? B4 G4 FO 78 C9 ..D.wo. cvvneos p-

E8P1B |7C B4 28 Flemmmmmmemmemmnn e a2 e e

EBB20 |84 78 A8 @3 LU Ll =] ;

ES03@ |1C F3 4C 46 .

E8P48 | 9F B2 48 F4

ESP58 | 6@ GE 2A @2

E860 | 3C F6 CO SF

ESN78_ |94 B1 68 F? 3%

Esege |Ea 98 50 o1 (N

E809@ | 5C F¢ 24 @8

ESPA@_|F9 @@ 88 Fa Cancel |

ESPE@_|F@ 83 DI 0@

E8ACA | ?C FC 94 &F

E8PDA_|%D @@ A8 FD CB BE 95 @@ BC FE CB FD B8C GO 78 FE ..oooueceennn. )

ES8PEB_|AE 62 85 BA D4 FE 4@ 37 7E @@ 38 FF 26 76 77 66 .hb....E7~.8_&uu.

ES8PFA_|9C FF 24 1n 71 BB @8 00 EA 1D 6B 88 64 68 28 7C ..5.q.....k.d.{!

F810B |65 @@ C8 B@ CH 2F 68 B0 2C @1 A8 33 5B 68 98 01 e.... " .,..3[...

E8118 |h4 82 56 B8 F4 B1 nB 17 52 B0 58 B2 a6 ED 4D 88 ..U.....R.X...M.

E81268 |BC @2 4C B8 4h B8 28 B3 64 4B 46 B8 84 63 B6 CA ..L.J. .dKF.....

F241 1R 472 AA FR AT AR 76 2IF A 4" A4 78 LCL 3 HA BRA A4 B =2 1. vl ;I
e Log =10 x|
CRC of lnaded file: D3E 4 d

|Readv

After successful programming the Config-Tool reports as follows:

\il) Firmware update succeeded

x|

The device then operates with the new firmware.

Possible sources of error

- If firmware is selected which does not correspond to the sensor, the error message
‘Invalid Firmware-Filename for this module’ is displayed.

- When updating ANACON-UMB or IRS21CON-UMB, the RS232 connection must be
plugged directly into the module to be updated.

- An ISOCON-UMB cannot be updated using this procedure (see page 17, Manual Update

with HexLoad).

Lufft
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Calibration of a VS20-UMB visibility sensor

Status 23.02.2007 Version 1.2

Start by creating a sensor list, containing the VS20-UMB to adjust. Example:

—ioix
Sensor Selection
Tupe of Sengzar In]
|IRS21CON-UME | |
Save/Exit |
Add | Delete | F aclify Canfigure | Cancel/E =it |
Update Channellizt | Firmwareupdate Sensor |
Selected Sensors
D IT_l,lpe Adress IChanneIs IActive Channels I
1 R25-UrE 21493 g 2
1 AMACOM-UME 24577 123 2
1 WS 20-LME 12289 25 a
Click Sensor to edit/remove Sensor Double Click Senzor to edit active channels
Autozcan | Werify | Save to Disk | Load from Disk |

Then chose ,Save/Exit’, ,Calibration a ,VS20-UMB.

Run the calibration according to the description in the text field and like described in the

manual from the calibration kit. See picture below.

Eonfig—Software—UMB
Eile Edit Calibration Help

r—Calibration Stepz

12289 |
(Ol I
Calibration process WS20-UMB Start |
(]
Step1
€13 Required items: Stop |
11 Calibration kit visibility (8366, UKALT)
4
The calibration procedure will take about 10 minutes.
ol ‘Wwhiern the calibration process iz interupted, the Y520
will nat meazure until reset or pawer off,
K Freszsz "Start’ when you have all the equipment ready
and you want to proceed
L Freszz "Stop' to cancel
8
[@l:]
S cattering coefficient

=10l x|

Enter geattering coefficient here

‘Lufft
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Miscellaneous

,Edit’ a ,Password entry’ allows the user to change in a different user group with advanced
possibilities.

Parameters only adjustable by modifying the file ULSPS.INI:

[Settings]

LogToFile=1

Writes the measurement values into a log file, file name see ,LogFileName’. The column
headers are formatted GrouplD:ID:Channel (see table of measurement values).

LogFileName=Values.Txt
Basic file name for the log file. Will be expanded by the current date. The software creates a
new file for every new date.

MaxRetriesForProtocolWhenFailure=2
Number of retries per command, before a failure is reported.

AdditionalTimeoutinMSForSlowConnectionsToHost=0

Time in ms, which is waited additionally to the period of reply specified in the UMB protocol,
before for this instruction Timeout is produced. The times specified in the protocol applies to
direct 1:1 communication. If the query is made e.g. by GPRS consider using 10000 (ms,
corresponds with 10s) here. Note: With 2 repetitions for each instruction (see
MaxRetriesForProtocolWhenFailure) it takes 3x10s = 30s, before this instruction is rated as
.Failed. Absolutely consider if an ,Autoscan’ is to be accomplished, and/or a measured value
query is run with a short interval.

AutoScanDeltaForFail=3

With ,Autoscan’ for each possible group by address 1 beginning ,a ,Verify’ command is sent.
If the device does not respond the next AutoScanDeltaForFail-1 addresses in ascending
order are queried with ,Verify'. The queried groups are 1 to 14 (group 0 is used for equipment
spreading broadcasts, group 15 are masters, here the software itself.

Example: Messurement setup with 1 device of group 2 Id 1 and 1 device of group 3 Id 2.
AutoScanDeltaForFail is set to 3.
List of queries (addresses, in Groupid:ld notation):

1:1 — Failed
1:2 — Failed
1:3 — Failed
2:1-0K

2:2 — Failed
2:3 — Failed
2:4 — Failed
3:1 — Failed
3:2-0K

3:3 — Failed
3:4 — Failed
3:5 — Failed
4:1 — Failed
4:2 — Failed
4:3 — Failed
5:1 — Failed
5:2 — Failed
5:3 — Failed

N

Lufft
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6:1 — Failed
6:2 — Failed
6:3 — Failed
7:1 — Failed
7:2 — Failed
7:3 — Failed
8:1 — Failed
8:2 — Failed
8:3 — Failed
9:1 — Failed
9:2 — Failed
9:3 — Failed
10:1 — Failed
10:2 — Failed
10:3 — Failed
11:1 — Failed
11:2 — Failed
11:3 — Failed
12:1 — Failed
12:2 — Failed
12:3 — Failed
13:1 — Failed
13:2 — Failed
13:3 — Failed
14:1 — Failed
14:2 — Failed
14:3 — Failed

Thus 45 telegrams, in order to find the 2 devices (with this ID). Since every ,Failed’ is
repeated 2 times (default setting), that is altogether 131 queries. If now
AdditionalTimeoutInMSForSlowConnectionsToHost is set to 10s ,Autoscan’ takes about 25
minutes - so choose the parameters carefully if the ,Autoscan’ function is to be used.

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 16
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Manual Update with HexLoad

The following procedure must be applied if a sensor update using the Config-Tool was
interrupted or in the case of an ISOCON-UMB.

Update ISOCON-UMB

Disconnect the power supply and the connected sensor from the ISOCON-UMB module
Connect the RS232 interface of the ISOCON-UMB module to the PC

Start HexLoad (...\Programme\Luff\UMB-Config\Hexload\HexLoad.exe)

Load the current mot file with ‘File’ > ‘Open’. This must (!!!) have the file designation
‘isocon_release_Vxx.mot’, where ‘xx’ specifies the version number.

Switch on the power supply of the ISOCON-UMB module.

‘BTL_ISOCON_VXx...." must now be displayed in HexLoad in the ‘Target’ window next to
‘Application’.

PN

2

A HexlLoad ¥3.00j -0 x|

File Edit Wiew Target Options Wwindow Help

1 Project =100 x| | FeRElEs =10l x|
Hexdile: , 2.mot Range: E8000 - FDFEF
COM Port: . CRC: =

Baudrate: 19200 Application: BTL ISOCOMN Wl Jun 6 2006 15:5
CPU: TRR; o nipin

BTL Version BTL ¥3.00

B Current data - [N:,PROJEKTE},0509 150 10| x|
agess: [0:£8000  [ul w2| )

[Address [@ [1 [2 [3[4[5[6[7[8[9 A[B[C[D][E]F[ASCII lil
""" rAAAA (2D 2D 2D 2D 2A 49 53 4F 43 4F 4F 2R 2D 2D 2D 2D ——— TROCON ———

7. Start the programming with F9.

8. If programming is successful the message ‘Job succeed’ is displayed; then exit HexLoad.
9. The module is now ready for operation with the new firmware.

Manual Update of IRS21CON-UMB
If it is necessary to update an ISR21CON-UMB module manually, proceed as in the case of

‘Update ISOCON-UMB’, where the name of the mot file must correspond to
‘IRS21con_Vx_x.mot’.

B4
‘Lufft
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Manual Update of VS20-UMB, R2S-UMB

1. Disconnect the power supply of the sensor from the ISOCON-UMB

2. Switch on the power supply of the ISOCON-UMB module

3. Connect the RS232 interface of the ISOCON-UMB module to the PC

4. Start HexLoad (...\Programme\Lufft\tUMB-Config\Hexload\HexLoad.exe)

5. Load the current mot file with ‘File’ > ‘Open’. The file must (!!!) have the following
designation, where ‘xx’ specifies the version number.
e VS20-UMB: ‘vs20_release_ Vxx.mot’
e R2S-UMB: ‘R2S_Release_Vxx.mot’

6. Connect the power supply of the sensor to the ISOCON-UMB module.
7. The following test must now be displayed in HexLoad in the ‘Target’ window next to

‘Application’:
e VS20-UMB: ,BTL_VS20 V...
7 Project =k =18/x|
Hexfile: vs20_release_V1J.mot Range: E&000 - FDFEF
COM Port: . CRC:
Baudrate: 19200 ApplicationC_BTL V520 V3 JJh 6 2006 16:04:
CPU: ATOCI 0 B aPin
BTL Version BTL ¥3.00
e R2S-UMB: BTL R2S V...
Hexfile: R25 Release V4%.mot Range: E8000 - FDFEF
COM Port: i CRC:
Baudrate: 19200 Application: BTL_R25 V2 Jul)3 2006 09:44:5
CPU: ToC20=01pTh
BTL Yersion BTL ¥3.00

8. Start the programming with F9.
9. If programming is successful the message ‘Job succeed’ is displayed; then exit HexLoad.
10. The module is now ready for operation with the new firmware.

ey
Lufft
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